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Welcome
iSYMED Localizer is a lightweight localization tool for your .Net 1.1 and .Net 2.0
applications. Its main purpose is to enable a translator to create localized executables
(executable files) independent of the developers. iSYMED Localizer scans the target
executables (normally files with type exe and dll), will store the text resources, its
original text and localized texts in a MS-SQL database and makes it easy to generate
language resource executables on the fly.
So, use iSYMED Localizer for ...
·
·
·
·
·

creating localization projects independent of the developers
scanning the original executables for text resources
detecting modifications in the original executables
translating the texts in a modern environment
generating localized executables for multiple languages.
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2

Introduction

2.1

Prerequisites

Introduction

iSYMED Localizer is a tool for localizing .Net applications and, quite naturally, iSYMED
Localizer itself is also a .Net application - written for the .Net 2.0 framework. For this
reason, it has some prerequisites which more or less derive from the minimum
operating system and hardware requirements for .Net 2.0.
Following the Microsoft recommendations (see
http://msdn2.microsoft.com/en-US/library/ms229070.aspx), you will need at least
Microsoft® Windows® 98 or higher for .Net 2.0.
The .NET Framework cannot be installed on the following operating systems:
·
·
·
·
·

Microsoft Windows 95
Microsoft Windows NT® Server
Windows NT Workstation
Windows Server 2003, Enterprise Edition for Itanium-based Systems
Windows Server 2003, Datacenter Edition for Itanium-based Systems

iSYMED Localizer uses the Microsoft tools al.exe and resgen.exe for creating satellite
assemblies. These are contained in the .Net Framework Software Development
Kit Version 1.1 (for localizing .Net 1.1 applications, download here) and/or
Microsoft .NET Framework Software Development Kit v2.0 (for localizing .Net
2.0 applications, download here).
Note: If you have Visual Studio 2003 or Visual Studio 2005 installed, the tool versions
1.1 respectively 2.0 are already installed at your computer.
The iSYMED Localizer database requires Microsoft SQL Server 2000 or Microsoft SQL
Server 2005. It will also run on Microsoft SQL Server 2005 Express Edition.
The Express Edition can be downloaded without charge from Microsoft (
http://msdn.microsoft.com/vstudio/express/sql/download).
Your iSYMED Localizer license is protected by a hardware dongle. Please
insert it into a free USB port of your computer.

2.2

How it works
So that you can work efficiently with iSYMED Localizer, please take some time to
understand its way of operation for generating localized executables.
For demonstration purposes, we will use a small sample application which you can
find in the program folder of iSYMED Localizer. It is simply called 'Sample' and
consists of the compiled executable files sample.exe and child.dll. The main (startup)
program is sample.exe, while the child.dll is a .Net class library. During development,
'child' was set up as a sub-project of the main program 'sample'. After installation,
the file structure in the Sample directory looks like this:
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If you start sample.exe, it will display a small dialog like this:

As the developer of this small application flagged the dialog as Localizable, its
localizable texts are stored in so called resources which are compiled and linked into
the executable. These resources are:
· the title of the window ('Invariant culture')
· the label ('I am a culture-invariant dialog.')
· and both buttons.
iSYMED Localizer will now scan (or parse) the executable, extract the localizable text
resources and put them into a database. Before scanning, one must tell the localizer
into which language the translation will take place. We will explain later how to set up
a translation project and how to scan the files. After this step, the text is stored in the
database together with status information, the resource name (or 'resource key'), the
original text and the translated text:

Now it will be the translator's job to localize (translate) the texts. In this example, the
translator will translate into German:
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When finished, the translator can generate a so called localized satellite resource Dll
(dynamic link library) which will be placed in a folder beneath the current source
executables. This step is also explained later in detail.
The result will look like this:

The 'de' folder (de = Deutsch = German) contains the localized resource Dlls
(provided the translator has translated both files):

If the translator's computer is now running in the target language (e.g. by setting the
culture in the regional settings or by setting the culture by code), the localized dialog
will now appear like this:
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Summary:
The localization process using the iSYMED Localizer is done by
·
·
·
·

setting up a translation process by including source executable files
scanning the source files into a database after specifying the target language
translating the texts in the database
generating target resource Dlls which are placed beneath the source executable
folder
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Manage databases

3.1

What is the database for?

Manage databases

iSYMED Localizer uses a database mainly for storing your translation work. So it is
possible to store all your projects in one place, save the original and translated texts,
search for texts quickly, save translation status, make version comparisons and
generate the target files. Furthermore, the iSYMED Localizer database can hold a
glossary which makes it possible to reuse your translation among all your projects.

3.2

Install a database
When running iSYMED Localizer for the first time, the following dialog will appear:

This means that iSYMED Localizer is not configured and needs the installation of a
database. As stated in the Prerequisites 4 , you need a running Microsoft SQL Server
instance before your database installation can take place.
Click Select Database in the File menu in order to start the database installation
dialog:
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In the Server combo box, you will find all servers which could be found in your
environment. Please select the right one. Then you have to select whether your server
needs Windows authentication or SQL Server authentication. Please contact
your server administrator if you are not sure. Only if you selected SQL Server
authentication do you need to enter User name and Password.
In the Database field you can enter any name for your new database. It is preconfigured for the name iSYLocalizer.
Now, press Run and start the installation process which takes a few seconds. If
successful, you should see the following dialog:

If you were not successful, please verify that you entered the correct settings in the
database installation dialog and repeat the installation process again. If you are still
not successful, please contact your server administrator.
If the installation succeeded, you will find the database name and server name in the
lower left corner. These settings are stored in the configuration settings. Each time
when you start the program and the database can be connected, you will find the
database setting here.
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If needed, you can install different database in different places. For each of your
database installations, you may run Select Database again. However, you do not
need to install different databases for each of your projects. Normally, it will be
sufficient to install one database and have several projects in it. Especially if you want
to use an own glossary among your projects, you can exchange translations only
between the projects in one database. It is not possible to have one glossary shared
between different databases.

3.3

Select a database
Selecting a database is quite easy: Simply call Select database in the File menu
and enter the settings which you entered when installing the database:

From now on, iSYMED Localizer will automatically re-open this database when
starting up. Of course, if you want to select a different database later on, you can call
Select database again.
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Manage projects

4.1

Create a project

11

A project holds all information related to one software application which is intended to
be localized. The application may consist of one or more modules (normally one
executable file and several DLLs).
For creating a localization project, the first step is to define a name for it and prepare
the database.
This is done through the New project in the File menu:

Please enter the project name now. As you can read in the dialog, the project name
will be the main key for your localization project and cannot be changed later on. So
please be careful in selecting your project name.
Note:
A project consists of source files and their translations. If you only create a project as
described above but do not add any source files, the project remains 'imaginary' and
will not be saved when closing. Only if you add one or more source files to the project
(see 'Insert and remove source files' 13 below), can it be saved and later re-opened.

4.2

Delete a project
You can delete a project if you no longer need it by selecting Delete project in the
File menu. Projects can only be deleted if there is no project currently opened. So if
you are just editing a project, the Delete project menu entry is dimmed and not
accessible. In order to delete a project, you may need to close your current project
using
After your project is deleted, your translation work is completely destroyed and
cannot be restored. In order to prevent unintentional deletion, iSYMED Localizer asks
you to confirm twice that you really want to delete the project.

4.3

Open a project
You can open a project by selecting Open project in the File menu or by clicking its
toolbar icon:

You will be asked to select one of the projects available in your current database:
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Please make a selection and press OK. The project will be opened and its settings will
be shown.

4.4

Save and close a project
If you have an open project, you can save your current work at any time by selecting
Save project in the File menu. While saving is not needed normally because iSYMED
Localizer will save your work before exiting the program, it is recommended to save
before leaving your computer for a longer time. You do not want to risk any loss of
data due to any event which could make your computer crash.
Also you do not normally need to close a project explicitly, as iSYMED Localizer will
save and close your work before exiting. However, if you want to change to another
project without exiting iSYMED Localizer, you can close the project using Close
project in the File menu and open another project with Open project.
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Source files

5.1

Insert and remove source files

13

As mentioned above, the source files for your localization in iSYMED Localizer are
executable (EXE) files and dynamic link libraries (DLLs). You must tell iSYMED
Localizer which input files belong to your projects. You can achieve this in an open
project by selecting Add files for localization in the File menu. Alternatively, you
can click the related tool bar item:

A Windows file selection dialog will appear. Please select one or more files which are
related to your project. These file need to be .Net 1.1 or .Net 2.0 executables or DLLs.
Other file types will lead to errors when you want to scan them later on.

Of course, you can add additional files at any time. For example, if a first version of
the application to be localized contains a certain number of files, further versions
could contain more files which have been added as soon as available.
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After adding the source files, you can see the files including their location (File folder)
and some settings in the table below the Source files tab page.
If you want to remove a file from your project, click and mark it in the Source files
table and select Remove file from localization in the File menu or click its icon in
the toolbar:

5.2

Set source file attributes
For large projects it may take a long time to generate the localized files. This could be
rather annoying if you want to translate parts of your project, generate the target
files and test the results often. For this reason there is a function to exclude some of
your project files from the process of generating the localized files. If you want to
exclude one or more files, put ticks in the relevant boxes in the Exclude from
generating column.
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Normally one of your files in the project is the startup module. If you want to start
your translated application directly from iSYMED Localizeryou can put a tick in its box
in the Startup program column to mark it as the startup program.
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6

Translate resources

6.1

Scan source files

Translate resources

At this point, you should have been able to set up a database, create a project and
insert source files into your project. If you have done so, you can click the Translate
tab.
If you did not scan any files for this project up to now, you will see an empty table
which looks like this:

The table is empty because you did not yet scan (or parse) your source files for
localizable resources. You can do this by selecting Scan source files in the
Translate menu or by clicking the Source files icon in the toolbar:

The Scan source files dialog will appear and asks you to select the scan mode:
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· With Scan source files and update existing language you will update an
existing project, usually because your source files have been updated. Select this if
you have received a new application version from your developers and you want to
update the localized executables as well.
· With Prepare a new language and scan source files for it you will prepare the
translation tables for a new target language. Select this if you are scanning your
source files the first time for a new target language.
After you press Scan iSYMED Localizer will scan (parse) the files in the Source files
table and - if successful - display the resources in a translation table (see Files and
resources) 18 .

6.2

Working with multiple languages
If you want to translate not only one but multiple languages, you will repeatedly scan
the source files (see Scan source files) 16 , each time with the Prepare a new
language and scan source files for it option.
If you want to switch between the languages, make your selecting in the Current
language combo box in the toolbar:
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The translation table will immediately display its entries in the new selected
language.

6.3

Files and resources
If you have an open project and have scanned your source files successfully, your
translation table will look something like this:

You will see a display of your source files in the same order as in the Source files
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table. On the left of the filename, you will find one of these symbols:
the red flag, if your file contains at least one untranslated entry
the blue flag, if your file contains no untranslated entries but at least one
automatically translated entry
the deletion mark, if your file contains only deleted entries
the globe, if your file contains only translated entries

If you open a file by clicking the small box on the left containing a plus sign, you will
see all resources contained in the file:

In this case, the file sample.exe contains only one resource called Sample.
FormMain.resources. However, a file could contain lots of resources which could be
forms, user controls or string tables. All of them show the names which were defined
by the developer. The resources are also shown with the same symbols as the files
which makes it easy to see which of the resources in your files contain untranslated
texts and which are translated completely.
Again you can open a resource by clicking the plus sign on the left of it. Now you will
see the actual translation entries:
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The Resource key identifies the entry unambiguously in the resource. It may be
helpful if you have to contact the developer in order to understand the context of the
translation. The Original Text column shows the original text while Localized Text
is the column where you have to enter your translation in the currently selected
language.

6.4

Edit resources
It is important to know some basic rules for editing entries in order to work fast and
efficiently.
Firstly, it is important that you do not end the editing of a line by pressing the
Return key but by pressing the Tab key. As the localized text may hold multiple
lines, the Return key will insert a line break in the text field but will not jump to the
next line. A line break will enter an additional line in your text but as the line height
changes only after jumping to another line, you could be a little bit confused after
pressing Return. After a short time, you will find that editing this way is quite
comfortable.
Secondly, you can benefit by working with shortcut keys. You can display them by
right-clicking the Resource Key field in the current line and opening a context menu.
Depending on the editing state of your line, you can display the context menu also in
the other columns, but right-clicking in the Resource key field will always work. The
context menu looks like this:
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The shortcut actions are on the left and the corresponding shortcut keys on the right.
A summary of the complete editing features is shown in the following table:
Sym
bol

none
none

Key

Action

RETUR
Insert a line break. Editing will continue in the current field.
N
TAB

End editing and jump to the next entry (independent of state).

Ctrl-T

Mark a row as translated. Row will be ignored by Next untranslated
entry command.

Ctrl-U

Mark a row untranslated. Row will be found by Next untranslated
entry command.

none Ctrl-P Expand or collapse a grey file or resource line showing all entries in it.
Copy the original text to the localized text. This is helpful if you need
to modify the localized text only a little bit compared to the original
none Ctrl-O text. If you do not want to translate the original text at all (e.g.
names) you can leave the localized text empty but mark the localized
text as translated (Ctrl-T).
Ctrl-N Jump to next untranslated entry.
Ctrl-F

Find an entry by searching for original text, localized text or both. The
search is done over the whole project.

If you want to delete the localized text of one line, jump to that line, open the context
menu and press Delete localized text.
If you want to delete a whole resource, jump to the grey resource line and click
Delete single resource in the context menu. Note that after scanning the project
the next time, the resource will re-appear (without the localized texts) if it is still
contained in the source files.

6.5

Navigate and search the resources
In order to find texts quickly, iSYMED Localizer has a comfortable search feature.
Simply press the Ctrl-N shortcut when in the translation table or select the related
icon in the toolbar:

The Find dialog opens and asks for the text to search for:
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When you press Find next, the first line in the translation table is highlighted in
which the text being searched for is found. As there may be more than one search
result, pressing Find next again will jump to the next line where the text is found. If
the end of the search is reached, iSYMED Localizer will display a message box.
By default, both Search in original text and Search in localized text are
activated. If you want to search only for the original or for localized texts, please put
a tick in the appropriate box.

6.6

Import translated resources
It may happen that you want to make use of already existing satellite assemblies. For
example, you start a new project in iSYMED Localizer and you have localized
resources available already from another localization system.
In this case:
· Create a new project in iSYMED Localizer;
· Scan the source files for the desired language and leave the localized texts empty;
· Import an existing satellite assembly. The assembly must have the same language
as your desired language.
For importing, select Import in the Translate menu. The following dialog will
appear:
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If you press the ellipsis button at the right of the Resource assembly to add field,
you can select the satellite assembly containing the desired language. Now press
Import. If everything is successful, the localized texts are imported into the database
and the statistics below the translation table are updated.
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6.7

Translate resources

Export to MS Word
If you need to hand over the translation work or parts of it to a translator who does
not own iSYMED Localizer, you can export the texts of one language and of one
project into the new Word ML format of MS Word. Word ML is a XML file format using
special MS Word instructions. Word ML files can be read and written directly by MS
Word 2003 or higher.
For doing so, select Export to MS Word from the Translate menu. The following
dialog appears:

Click the button on the right of the Export file name field in order to choose a file
name and location for the export file. The file does not need to exist.
If you want to export only the untranslated and modified entries, leave the Export
also unmodified entries check box empty. If you want to export all texts, select it
(this might be helpful if your translator needs to revise the texts).
After this, click the Export button. If everything could be exported without problems,
iSYMED Localizer will report the success.

6.8

Translating in MS Word
As already mentioned in the chapter Export to MS Word
2003 or higher can display Word ML files correctly.

24

, only MS Word version

If you have created a Word ML file (having the file extension .xml), you can open it ...
· ... by double-clicking the file itself - this will normally open the Internet Explorer
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and display a Word editing window;
· ... by running Word itself and open the file through the normal File Open command;
Please take in account that MS Word will first run an integrity analysis after loading
the file. As your export file may be rather huge for a large localization project, this
may take a few seconds. You can watch the progress at the bottom status line in MS
Word.
After loading the file, MS Word may display the texts in a table like this:

In the first row of the table you will find the numeric language ID of your export file.
Please don't changed this. Otherwise, iSYMED Localizer may have problems in reimporting the file after the translation.
The second row shows the column descriptions. Please do also not alter this line.
The first column displays the original texts. The second one is for your localized texts.
The third column reflects the context of the texts in your application while column 4
displays the unique ID of the text.
Starting from row 3, you can enter your translations in the second column.
Please do NOT modify the contents in all other columns. Especially the Resource
ID is needed for re-inserting the translation into your project during import.
In order to improve the display during editing, you should make paragraph marks,
tab stops, and other non-printing characters visible by clicking the Show/Hide button
in the Standard toolbar:

You could also adjust the column widths on the top ruler as it fits best to your display.
After the adjustments, the table might look like this:

© 2006 iSYMED GmbH

26

Translate resources

In order to create a proper localization, insert hard line breaks only at those places
where the original text has also hard line breaks. Please see the example line break in
the last row of the screen shot above.

6.9

Import from MS Word
If the translation was made through MS Word export and editing in MS Word, you will
want to re-import the translation when it is finished. In order to do so, select Import
from MS Word in the Translate menu. Make sure that the file is no longer in use by
MS Word - otherwise the import will fail.
The following dialog will appear:

Please press the button on the right of the Import file name field in order to select
your Word ML file containing the translation texts. iSYMED Localizer will now check if
the language in the Word ML file fits to the currently selected language. If so, it will
import all new texts of your Word ML file into the current translation table. If there
was no problem, iSYMED Localizer will report success by a message box like this:
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There is still one thing to mention: iSYMED Localizer creates unique resource IDs
during scanning your application the first time. These resource IDs are written to the
export Word ML file and will be used again during the import. This mechanism works
only of your use the same iSYMED Localizer installation for exporting and reimporting again because another installation will create different unique resource IDs.
However, in order to make it possible that you can also use a different installation for
re-importing your (localized) Word ML file, iSYMED Localizer will use a different logic
for re-importing in this way. If it cannot match the unique resource IDs in the Word
ML file with those in the database, it will try to match the entries in the selected
language and project through comparison of the original texts. This has one
disadvantage: If the Word ML file contains some entries having the same original text
but different localized texts, iSYMED Localizer will not be able to make the correct
assignments and set all translated texts of the equal entries to the localized texts of
the last Word ML entry of these equal texts.
So it is highly recommended to use the same iSYMED Localizer installation for
exporting and re-importing again.

6.10

Using the glossary
After using iSYMED Localizer for a while, you will find that there are many texts in
your projects which need to be translated again and again. This is not only a waste of
time but it can lead to inconsistency in your projects as very often the various
translations of the same original text will vary.
The purpose of a glossary is to prevent repeated translations. It works projectindependent and will help a new project to benefit from your former translations. It is
quite simple to use the glossary. If you have a translation table open, select Open
glossary in the Tools menu. The following dialog will appear:
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If you want to copy all the translated entries in your current project into the glossary,
click the Update glossary button at the top of the window:

You can repeat this from time to time if you have translated new entries in your
project. The glossary will overwrite those entries which have still the same original
text but a modified localized text.
Click the Update localization button if you want to have untranslated texts in your
project translated automatically:

The following rules apply for auto-translating texts using the glossary:
· Only resource entries marked as untranslated will be auto-translated.
· Only resource entries whose original texts are exactly the same as in the glossary
will be auto-translated. 'Exactly' means the texts do not differ, neither in upperand lowercase, nor in the number of blanks or white spaces between words.
· The auto-translated texts in the translation table are marked with a blue flag. When
searching untranslated texts using the Next untranslated entry command the
blue entries will not be found.
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Generate target files

7.1

Generate target files

29

At any time during the localization process you can create the localized satellite
assemblies. This is done by selecting the Generate tab page:

Then select Generate target files in the Target files menu or click the related icon
in the toolbar:

The satellite assembly generation will start and will produce a report in the text field.
If everything was successful, you will find a message like this at the end of the
report:
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If something went wrong, you will find the error messages in red in the report. Please
check these messages carefully and try to find out the reason for this behaviour. Very
often the reason is that you are currently running the program for which you want to
produce the satellite assembly, and in this case, iSYMED Localizer cannot overwrite
the existing satellite assemblies.
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At the end of the report you will also find a line which tells you how many files in your
project were excluded from generating the target files. You can change these settings
in Set source file attributes 14 . Especially if you expected some texts to be translated
but they have not been, verify that these settings are correct.
If everything was successful, you can find the satellite assemblies in folders which are
located in the same folders as your source files. They are named in their respective
culture. For example, in our Sample project, you will find the German satellite
assembly in the de folder in parallel to the source files:

The de folder contains the actual satellite assemblies:

Other languages would appear in parallel to the de folder.

7.2

Run the startup program
Provided you have marked one of your source files as startup program (see Set
source file attributes) 14 and you have successfully translated your project and
generated the satellite assemblies, you can easily start your localized application by
selecting Run startup program in the Target files menu or by clicking its icon in the
© 2006 iSYMED GmbH
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toolbar:

This is quite useful if you want to localize a large project file by file, resource by
resource and you need to start the localized application very often in order to test the
translation.
Please don't forget to end the localized application after verifying your translation.
Otherwise, you would prevent iSYMED Localizer from generating the satellite
assemblies in your next round of translation.
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